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本資料は表記のバージ ョ ンの英語版を翻訳したもので、内容に相違が生じる場合には原文を優先します。 資料によっては英語版の更新に対応していないものがあります。 日本
語版は参考用としてご使用の上、 最新情報につきましては、 必ず最新英語版をご参照く ださい。

概要
Zynq®-7000 All Programmable (AP) SoC ベースのエンベデッ ド  システムは、 インターネッ トに接続する と、 動作中にソフ
ト ウェア、 ハード ウェア、 およびデータ  ファ イルをアップデート できます。 インターネッ ト経由でアップデート される
パーティシ ョ ンは、 安全性を確保するために保護される必要があ り ます。 このアプ リ ケーシ ョ ン ノートでは、 Zynq-7000
AP SoC が動作している状態でエンベデッ ド  システムを安全にアップデートする方法について説明します。

含まれるシステム
リ ファレンス  システム (system_update) には、 次のソフ ト ウェア プロジェク トが含まれています。

• fsbl

• hello

• partition_loader

• u-boot

• hello_update

これらのソフ ト ウェア プロジェク トの ELF ファ イル、 暗号キー、 および Bootgen イ メージ フォーマッ ト  (BIF) ファ イル
は、 system_update/completed デ ィ レ ク ト リ にあ り ます。 ソース  フ ァ イルは、 hello_src および
partition_loader_src ディ レク ト リにあ り ます。

はじめに
SoC または FPGA ベースのエンベデッ ド  システムを再プログラムする場合の一般的な方法は次のとおりです。

1. エンベデッ ド  システムの電源を切断する。

2. ザイ リ ンクス  ソフ ト ウェアがロード される  PC へシステムを物理的に接続する。

3. すべてのパーティシ ョ ンを含むイ メージを不揮発性メモ リ  (NVM) へダウンロードする。

4. 電源を投入する。

この間、 エンベデッ ド  システムは利用できません。 インターネッ ト に接続する と、 Zynq-7000 デバイスでは動作中に
パーテ ィシ ョ ン  ローダーまたは U-Boot を使用して、 ソフ ト ウェア、 ハード ウェア、 またはデータをロードできます。
リ ファレンス  システムを用いて、パーティシ ョ ン  ローダーと  U-Boot を使用してシステムをアップデートする方法を示
します。

このアプリ ケーシ ョ ン ノートは、 次のセクシ ョ ンで構成されます。

• 「システム アップデートの利点」 では、エンベデッ ド  システムを リモートからアップデートする理由を挙げています。

• 「システム アップデートの高位記述」 では、 システムをアップデートするために必要なタスクを紹介しています。 こ
れらのタスクは、 ファ ク ト リで実行されるタスク と、 フ ィールドでエンベデッ ド  システムに対して実行されるタスク
に分かれています。

• 「システム アップデートの実行」 では、 ザイ リ ンクスのソフ ト ウェア開発キッ ト  (SDK) を使用してソフ ト ウェア プロ
ジェク ト を構築します。 その後、 SDK でイ メージを作成およびプログラムします。 SDK を使用したソフ ト ウェア プ
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ロジェク トの作成に不慣れな場合は、システム作成の手順を説明している 『Zynq-7000 All Programmable SoC のセキュ
ア ブート 』 (XAPP1175) [参照 1] を参照してください。 このセクシ ョ ンでは、 パーティシ ョ ン ローダーと  U-Boot を使
用してシステムをアップデートする方法についても説明しています。

• 「システム アップデートのテス ト 」 では、 リ ファレンス  システムの実行方法および結果の確認方法について説明して
います。 システムを安全にアップデートするには、 AES 暗号および RSA 認証を使用します。

• 「システム アップデートのセキュ リティ」 では、 機密性および完全性を確保したアップデート方法について説明して
います。

必要なハードウェアおよびソフ トウェア
Zynq AP SoC のソフ ト ウェア アップデートにおけるハードウェアおよびソフ ト ウェアの要件は次のとおりです。

• ZC702、 ZED、 または MicroZed 評価ボード

• AC 電源アダプター (12VDC)

• USB Type-A/Micro-B ケーブル

• ザイ リ ンクス  プラ ッ ト フォーム ケーブル USB II

• ザイ リ ンクス  ソフ ト ウェア開発キッ ト  2014.3

• ザイ リ ンクス  Vivado® Design Suite 2014.3

システム アップデートの利点
システム アップデートがもたらす主な利点は次のとおりです。

• 開発サイクルを短縮 ： 新機能を簡単に追加できるため、 最初のリ リースにすべての機能を含める必要がない

• エラー管理 ： パッチでエラーを修正できる

• ソフ ト ウェアまたはハード ウェアをアップデートするこ とで、 シ リ コンのライフ  サイ クルが延長される

• 患者カルテなどの機密データ記録を確実かつ安全に管理できる

• ハードウェアまたはソフ ト ウェア動作を時分割多重化するこ とによって、 シ リ コンのシステム機能を向上させる

• 消費電力を リモート制御する

• 安全への侵害が発生した場合、 または従業員が退職した場合にリモートから情報を削除できる

• 最新のソフ ト ウェア/ハードウェアを備えるこ とによって、 エンベデッ ド  システムのライフ  サイ クルが延長される

システム アップデートの高位記述
これまで、 フ ィールド  プログラマブル ゲート  アレイ  (FPGA) は設計者がプログラムするもので、 エンド  ユーザーが機能
を変更するこ とはあ り ませんでした。Zynq-7000 AP SoC デバイスは、ユーザー主導のシステム アップデート をサポート し
ているため、 製品の機能性が向上します。 プロセッシング システム (PS) とプログラマブル ロジッ ク  (PL) の両セクシ ョ ン
がプログラムできます。 従来のデバイス  ド ラ イバーを使用して PS と  PL の両方をプログラムできるため、 ユーザー主導
のアップデートが可能です。

ユーザー主導型アップデートのほかにも、 サード  パーティ  ベンダーから、 多くのエンベデッ ド  システム アップデートに
対応するデバイス  マネージメン ト  ソフ ト ウェアが提供されています。これらのベンダーは、OMA DM (Open Mobile Alliance
- Device Management) 規格への高位インターフェイスを提供し、 フ ィールドに展開された多数のエンベデッ ド  システムの
効率的で安全なアップデート をサポート しています。

このアプリ ケーシ ョ ン ノートで使用するシステム アップデート方法は、 ユーザー主導とデバイス  マネージャー主導のシ
ステム アップデート をサポート します。
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システム アップデートには、有線または無線いずれかのインターネッ ト接続を使用しますが、無線接続の方が効率的です。
1 回のシステム アップデート で、 1 つのパーティシ ョ ンがアップデート されます。 パーテ ィシ ョ ン とは、 ソフ ト ウェア
(ELF/BIN）、 ハード ウェア (ビッ ト ス ト リーム)、 またはデータ  ファ イルのいずれかです。 アップデートは、 セキュア モー
ドまたは非セキュア モードで実行可能です。図 1 に、システム アップデートの概要を示します。 こ こでいう ファ ク ト リ と
は、ソフ ト ウェアを開発してフ ィールド展開されたエンベデッ ド  システムに分配する主要 サイ トのこ とです。ファ ク ト リ
を使用する と、デバイス  マネージャーは開発の構造から独立して動作できます。 ファ ク ト リはパーティシ ョ ンを作成しま
す。 このパーティシ ョ ンは、 ファ ク ト リ またはデバイス  マネージャーによってエンベデッ ド  システムへ送信されます。通
常、 パーティシ ョ ンの最初のデスティネーシ ョ ンは、 エンベデッ ド  システムの DDR メモ リです。

こ こでは、 ファ ク ト リからエンベデッ ド  システムへのパーティシ ョ ンの伝送については詳し く説明しません。 通常、 この
伝送には有線または無線イーサネッ ト を使用します。

パーティシ ョ ンがエンベデッ ド  システムへ伝送された後、 パーティシ ョ ン ローダーまたは U-Boot のいずれかが DDR の
パーティシ ョ ンを DDR の別の場所、 オンチップ メモ リ  (OCM)、 またはコンフ ィギュレーシ ョ ン メモ リへコピーします。
U-Boot を使用する と、 DDR のパーティシ ョ ンを Quad-SPI に書き込むこ とができます。 リブート時にエンベデッ ド  システ
ムが最新のパーテ ィ シ ョ ンを ロードする場合には Quad-SPI への書き込みが必要です。 パーテ ィ シ ョ ン ローダーは
Quad-SPI への書き込みをサポート していません。

パーティシ ョ ン ローダーは U-Boot よ り小さ くて使用が簡単です。U-Boot はパーティシ ョ ン ローダーよ り機能性に優れて
います。 パーティシ ョ ン ローダーと  U-Boot は共にソフ ト ウェア、 ハード ウェア、 またはデータ  パーティシ ョ ンをコピー
し、 AES 暗号および RSA 認証をサポート します。 カスタム変更が必要な場合は、 パーティシ ョ ン ローダーへの変更を非
公開と して保持できます。 U-Boot はオープン ソースです。 一部のエンベデッ ド  システムは、 パーティシ ョ ン ローダーと
U-Boot の両方を使用します。

Zynq デバイスで実行する場合、 Linux はビッ ト ス ト リームなどのパーティシ ョ ンをロードできます。 Linux は、 パーティ
シ ョ ンを Quad-SPI へ書き込むこ と もできます。 Vivado Design Suite 2014.3 リ リースの時点で、 Linux のビッ ト ス ト リーム
コンフ ィギュレーシ ョ ン動作は、 セキュア モードでテス ト されていません。

注記 : ブート時のシステム アップデート を保持するには、U-Boot が NVM にアップデート情報を書き込む必要があ り ます。
Quad-SPI を NVM と して使用する場合は、 U-Boot sf write コマンドを使用します。

X-Ref Target - Figure 1

図 1 : システム アップデートのフロー図
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システム アップデートの実行
図 2 に、 システム アップデート  フローの機能を示します。 FSBL (ファース ト  ステージ ブート ローダー ) が不揮発性メモ
リ  (NVM) の hello ソフ ト ウェア プロジェク ト を DDR メモ リへコピーします。 hello ソフ ト ウェアは通信端末に 「Hello
World」 と表示します。 この hello プログラムの後に、パーティシ ョ ン ローダーが実行されます。 システム アップデート
を実行する場合、パーティシ ョ ン ローダーは hello_update をロード します。実行中、通信端末には「Hello World Update」
出力が表示されます。

実際のシステムでは、スケジューラーがプログラムの実行を管理します。このアプ リ ケーシ ョ ン ノートのソフ ト ウェア プ
ロジェク トは、 ブートやランタイム動作をエミ ュレートする経験則に基づいた リ ファレンス  システムを提供しています。
実際のシステムにおけるシステム アップデートは非同期的に行われます。 FSBL と hello のロードはブート時に発生し
ます。 リ ファレンス  システムでは、 CPU が hello から  partition_loader へ遷移する と きにランタイムがモデル化さ
れます。

SDK を使用してシステム アップデートする手順は次のとおりです。

1. fsbl、 hello、 partition_loader/U-Boot、 および hello_update ソフ ト ウェア プロジェク ト を作成します。

2. Bootgen を使用して system_update.mcs イ メージを作成します。

X-Ref Target - Figure 2

図 2 : ブート  タイム－ ランタイムの抽象化
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3. Flash Writer を使用して Quad-SPI に書き込みます。

4. SDK で FSBL および Hello プロジェク ト  テンプレート を作成します。 system_update という名前のディ レク ト リ を
作成して SDK を起動します。

5. [Workspace Launcher] のテキス ト  ボッ クスで <path>\system_update を参照して、 [OK] をク リ ッ ク します。

6. [File] → [New] → [Application Project] をク リ ッ ク します。

7. [Project Name] に 「fsbl」 と入力します。

8. [Target Hardware] → [Hardware Platform] で [ZC702_hw_platform] に変更して、 [Next] をク リ ッ ク します。

9. [New Project Templates] ダイアログ ボッ クスで [Zynq FSBL] を選択して、 [Finish] をク リ ッ ク します。

10. fsbl のコンパイル完了後、 [Project Explorer] ペインで [fsbl] を右ク リ ッ ク します。

11. [C/C++ Build Settings] をク リ ッ ク します。

12. [Symbols] をク リ ッ ク して、 + をク リ ッ ク します。

13. テキス ト  ボッ クスに 「FSBL_DEBUG_INFO」 と入力して、 [OK] をク リ ッ ク します。

14. FSBL プロジェク トの作成時に行った手順を繰り返して、 hello プロジェク ト と  hello_update プロジェク ト を作
成します。 [New Project Templates] ダイアログ ボッ クスで [Hello World] を選択します。

15. [Project Explorer] ペインで hello プロジェク ト を変更します。 変更したソース  ファ イルは、 hello_src ディ レク ト
リに格納されます。

a. [File Import] → [General] → [File System] をク リ ッ クして、hello/src に system update/hello_src/handoff.S
を追加します。

b. hello/src/helloworld.c を system_update/hello_src/helloworld.c に置き換えます。

新しい helloworld.c は、 コードに 3 つの行が追加されており、 hello プロジェク トが 「Hello World」 と表示
した後にパーティシ ョ ン ローダーが実行されます。

int main(): の直前に、 次の 2 行が挿入されています。

u32 PartitionLoaderStartAddress = 0x00400000;
void HandoffExit(u32 PartitionLoaderStartAddress);

cleanup_platform();: の後に次の行が挿入されています。

HandoffExit(0x00400000);

c. [Project Explorer] ペインで hello_update プロジェク ト を変更します。 helloworld.c の print ステート メン ト
を次のよ うに変更します。

print(“Hello World from updated hello”);

d. [Project Explorer] ペインで、hello_update/src/lscript.ld リ ンカー スク リプ ト を変更して、hello_update
を 0x400000 に配置します。

パーティシ ョ ン  ローダー

パーティシ ョ ン ローダーは、 ソフ ト ウェア、 データ、 またはハード ウェアのパーティシ ョ ンをコピーします。 パーティ
シ ョ ン ローダーは、 devcfg デバイ ス  ド ラ イバーのラ ッパーです。 devcfg ド ラ イバーの ソース  コー ド は、
XilinxProcessorLib/driver/devcfg_v* ディ レク ト リにある  SDK インス トール エリ アに含まれています。

PcapDataTransfer および PcapLoadPartition 関数は pcap.c にあ り ます。 PcapDataTransfer 関数は、 ソフ ト
ウェアやデータのパーティシ ョ ンをコピーします。ビッ ト ス ト リームがコンフ ィギュレーシ ョ ン メモ リにコピーされる場
合、PcapLoadPartition 関数が使用されます。暗号化せずに NVM から  DDR へビッ ト ス ト リームをコピーする場合は、
PcapDataTransfer 関数を使用できます。

パーティシ ョ ン ローダー関数の引数は、 ソース /デスティネーシ ョ ンのアド レス、 ソース /デスティネーシ ョ ンのサイズ、
およびパーティシ ョ ンの送信を復号化するか否かを示します。 パーティシ ョ ンのアドレスおよびサイズ パラ メーターは、
ハード  コード されています。

リ ファレンス  システムのパーティシ ョ ン ローダーは、 基本的なシステム アップデート機能を示します。 システム アップ
デート用のインターフェイスをユーザー (デバイス  マネージャー ) に提供するため、 パーティシ ョ ン ローダーの関数を変
更して、 変数あるいはメモ リ  アドレス と してアドレスおよびサイズ パラ メーターが与えられるよ うにします。
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パーティシ ョ ンのアドレスおよびサイズを取得するには、 次の 2 つの方法があ り ます。

• -debug オプシ ョ ンを使用して Bootgen を実行します。

bootgen -image hello_update.bif -o hello_update.bin -w on -debug

BIF がすべてのパーティシ ョ ンを含む場合、 Bootgen はアドレスおよびサイズ情報も提供します。

• FSBL のログ出力を使用して、 アドレスおよびサイズ情報を取得します。 FSBL_DEBUG_INFO オプシ ョ ンを用いて
FSBL をコンパイルする と、 ログが提供されます。

現在、 パーティシ ョ ン ローダーは RSA 認証を使用しません。 ザイ リ ンクスの RSA ライブラ リ を用いてパーティシ ョ ンを
認証する方法は、 『Zynq-7000 All Programmable SoC システム メモ リのランタイム整合性および認証の確認』 (XAPP1225) 
[参照 2] を参照してください。

次の手順に従って、 パーティシ ョ ン ローダー ソフ ト ウェア プロジェク ト を作成します。

1. [File] → [New] → [Application Project] をク リ ッ ク します。

2. [Project Name] に 「partition_loader」 と入力して、 [Next] をク リ ッ ク します。

3. [New Project Templates] で [Empty Application] を選択して、 [Finish] をク リ ッ ク します。

4. [Project Explore] ペインで [partition_loader] を右ク リ ッ ク して、 [src] を選択します。

5. [Import] → [General] → [File System] をク リ ッ ク します。

6. system_update/partition_loader_src を参照し、 すべてのファイルを選択して [OK] をク リ ッ ク します。

7. [Project Explore] ペインで partition_loader/src/lscript.ld を選択します。

8. リ ンカー スク リプ ト を変更して partition_loader を 0x600000 に配置します。

パーティシ ョ ン ローダーは、最初のブートで使用される  BIF 内に含まれるため、ランタイム時にはメモリ内に常駐します。

U‐Boot

U-Boot は、 さまざまな用途に使用されるユニバーサル ブート  ローダーであ り、一般に Linux カーネル、デバイス  ツ リー、
ルート  ファ イル システム、 Linux アプ リ ケーシ ョ ンをロードする場合に利用されます。 [参照 3] では、 U-Boot 用のユー
ザー マニュアルなどの資料を提供しています。 [参照 4] では、 U-Boot の設定および構築に関するザイ リ ンクスの資料を提
供しています。 組み込み Linux のほとんどのテキス トには、 U-Boot セクシ ョ ンが含まれます。

1. ザイ リ ンクスの Git サーバーから  U-Boot をダウンロードする場合、 次のコマンドを入力します。

git clone git://github.com/Xilinx/u-boot-xlnx.git
cd u-boot-xlnx

2. include/configs/zynq-common.h に、 次の define ステート メン ト を追加します。

#define CONFIG_CMD_ZYNQ_AES

3. 次のコマンドを入力して U-Boot を設定および構築します。

make arch=ARM zynq_zc70x (zynq_zed)

次に示すコマンド  セッ トは、 U-Boot を使用して PL を構成する方法を示しています。

promgen -w -b -p bin -o system.bin -u 0 system.bit -datawidth 32
Copy system.bin to a SD card.

4. XMD を起動して次の XMD コマンドを実行します。

connect arm hw
dow fsbl.elf
con
stop dow u-boot.elf
con

5. キーを押して自動ブート を回避します。

6. U-Boot のプロンプ ト画面で、 通信端末に次のコマンドを入力します、

mmcinfo
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fatload mmc 0 0x100000 system.bin
fpga load 0 0x100000 0x3DBAFC

7. 復号化してビッ ト ス ト リームを送信するには、 fpga コマンドを zynqaes に置き換えます。

zynqaes <srcaddr> <srclen> <destaddr> <destlen>

qspiboot の include/configs/zynq-common.h セクシ ョ ンは、 Linux カーネル、 デバイス  ツ リー、 およびルート  ファ
イル システムをロード します。 コマン ドは、 zynqaes を使用して hello_update をロードするよ うに変更できます。
system.bin パーティシ ョ ンは Bootgen で暗号化されます。

Bootgen

次の手順で SDK Bootgen GUI を起動します。

1. [Xilinx Tools] → [Create Zynq Boot Image] 

2. [BIF File Path] ダイアログ ボッ クスで、 パス と  system_update.bif ファ イル名を指定します。

3. + をク リ ッ ク して fsbl.elf を追加します。

4. [Add] をク リ ッ ク して、hello.elf、partition_loader.elf、および hello_update.elf ファ イルを追加します。

5. 出力ファイルと して system_update.mcs を指定します。

6. [Create Image] をク リ ッ ク します。

クワッ ド  シリアル ペリフェラル インタフ ェース (Quad‐SPI) のプログラム

1. [Xilinx Tools] → [Program Flash] をク リ ッ ク し、 SDK Program Flash を起動します。

2. system_update.mcs を参照して Image File 入力を完成させます。

3. [Offset] に 「0x0」 と入力します。

4. [Program] をク リ ッ ク します。

システム アップデートのテスト
1. ボー レート を 115200 に設定した Teraterm 通信端末を起動します。

2. 評価ボード上で、 ブート  モード選択スイ ッチ MIO5 を 1 に変更して、 Quad-SPI モードでブート します。

図 3 に示すよ うに、通信端末のメ ッセージ画面に FSBL、 hello、 パーティシ ョ ン ローダー、および hello update プログラム
のアクティビティが表示されます。 最初の hello ソフ ト ウェアでは、 「Hello World」 および 「Hello Brazil」 と表示されます。
コードがパーティシ ョ ン ローダーへ移動する と、 「Xilinx Partition Loader」 および 「Handoff Address:0x00600000」 と表示さ
れます。 hello システムのアップデートは、 「Hello World Update」 とい う メ ッセージで確認できます。
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X-Ref Target - Figure 3

図 3 : システム アップデート を示す通信端末の出力
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システム アップデートのセキュリテ ィ
インターネッ ト経由でシステムを リモートからアップデートする場合、 中間者攻撃にさら される可能性があ り ます。 ザイ
リ ンクスは、 機密性を保持するための AES 暗号および機密情報の整合性を保護するための RSA 認証を提供しています。

ファ ク ト リ で Bootgen を使用して、 AES 暗号化済みまたは RSA 署名済みのアップデート  パーティシ ョ ンを作成します。
Bootgen は、 ブート用のパーティシ ョ ンをすべて含むイ メージ、 またはランタイム アップデート用のパーティシ ョ ンを 
1 つ含むイ メージを作成できます。 Bootgen イ メージ フォーマッ ト  (BIF) ファ イルのセキュ リ ティ属性の使用については、
『Zynq-7000 All Programmable SoC のセキュア ブート 』 (XAPP1175) [参照 1] を参照してください。

パーティシ ョ ン ローダーは、 PcapLoadPartition および PcapDataTransfer 関数の引数を使用してセキュ リティ を
サポート します。 U-Boot は、 zynqaes コマンドおよび zynqrsa コマンドを利用してセキュ リティをサポート します。 リ
ファレンス  システムでは、 パーティシ ョ ン ローダーと  U-Boot を用いた信頼性の高いアップデート方法を示しています。

エンベデッ ド  システムでは、 パーティシ ョ ンの復号化や認証を行うために、 Zynq SoC がハード  AES 復号化と ソフ ト  RSA
ラ イブラ リ を提供します。

非セキュア モード とセキュア モードの違いは、 BIF ファ イルです。 図 4 に、 セキュア モードのシステム アップデート用
BIF ファ イルを示します。 この図に示すよ うに、 AES と  RSA のキーを入力します。

X-Ref Target - Figure 4

図 4 : セキュア システム アップデートの BIF

http://japan.xilinx.com
http://japan.xilinx.com/about/feedback.html?docType=Application_Notes&docId=XAPP1224&Title=Zynq-7000%20AP%20SoC%20%26%2312471%3B%26%2312473%3B%26%2312486%3B%26%2312512%3B%26%2312398%3B%26%2312475%3B%26%2312461%3B%26%2312517%3B%26%2312450%3B%20%26%2312450%3B%26%2312483%3B%26%2312503%3B%26%2312487%3B%26%2312540%3B%26%2312488%3B&releaseVersion=1.0&docPage=9


リファレンス システム

XAPP1224 (v1.0) 2014 年 10 月 22 日 japan.xilinx.com  10

リファレンス システム
このアプリ ケーシ ョ ン ノートの リ ファレンス  デザインは、 ザイ リ ンクスのウェブサイ トからダウンロードできます。

表 1 に、 リ ファレンス  デザインの詳細を示します。

リ ファレンス  システムは、不揮発性メモ リ  (NVM) と してクワッ ド  シ リ アル ペリ フェラル インターフェイス  (Quad-SPI) を
使用します。 Quad-SPI は、すべての Zynq-7000 評価ボードに搭載されており、プロダクシ ョ ン ボードでは一般的によ く使
用されます。 Quad-SPI を用いたシステム アップデート方法は、 NAND、 NOR、 または SD の NVM で可能です。

まとめ
Zynq All Programmable SoC のハードウェア/ソフ ト ウェア プログラマビ リティは、 エンベデッ ド  システムのライフサイク
ルにおいてさまざまなメ リ ッ ト をもたらします。動作中にユーザーまたはデバイス  マネージャーがシステムをアップデー
トできるため、 エンベデッ ド  システムの機能性、 有効性、 信頼性が向上します。 システムは、 Zynq デバイスが動作して
いる間に、 パーティシ ョ ン ローダーまたは U-Boot を使用する  2 つの方法でアップデートできます。

表 1 :  リファレンス デザインの詳細

パラメーター 説明

全般

開発者 Lester Sanders

ターゲッ ト  デバイス Zynq All Programmable SoC

ソース  コードの提供 あ り

ソース  コードの形式 VHDL、 Verilog

既存のザイ リ ンクス  アプ リ ケーシ ョ ン ノー トやリ ファレ
ンス  デザイン、 またはサードパーテ ィからデザインへの
コード /IP の使用

なし

シミ ュレーシ ョ ン

論理シ ミ ュレーシ ョ ンの実施 なし

タイ ミ ング シ ミ ュレーシ ョ ンの実施 N/A

論理シ ミ ュレーシ ョ ンおよびタ イ ミ ング シ ミ ュレーシ ョ
ンでのテス トベンチの利用

なし

テス トベンチの形式 N/A

使用したシ ミ ュレータ /バージ ョ ン N/A

SPICE/IBIS シ ミ ュレーシ ョ ンの実施 N/A

インプリ メンテーシ ョ ン

使用した合成ツール/バージ ョ ン Vivado 合成

使用したインプリ メンテーシ ョ ン ツール/バージ ョ ン Vivado インプリ メンテーシ ョ ン

スタティ ッ ク  タイ ミ ング解析の実施 なし

ハードウェア検証

ハードウェア検証の実施 あ り

使用したハード ウェア プラ ッ ト フォーム ZC702
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参考資料
1. 『Zynq-7000 All Programmable SoC のセキュア ブート 』 (XAPP1175)

2. 『Run Time Integrity and Authentication Check of Zynq-7000 All Programmable SoC システム メモ リのランタイム インテグ
リティおよび認証チェッ ク』 (XAPP1225)

3. www.denx.de/wiki/U-Boot

4. www.wiki.xilinx.com/Build+U-Boot#Zynq

5. 『Zynq-7000 XC7020 AP SoC 向け ZC702 評価ボード  ユーザー ガイ ド』 (UG850)

6. 『Zynq-7000 All Programmable ソフ ト ウェア開発者向けガイ ド』 (UG821)

改訂履歴
次の表に、 この文書の改訂履歴を示します。

法的通知
The information disclosed to you hereunder (the "Materials") is provided solely for the selection and use of Xilinx products.To the maximum extent
permitted by applicable law:(1) Materials are made available "AS IS" and with all faults, Xilinx hereby DISCLAIMS ALL WARRANTIES AND
CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether in contract or tort, including
negligence, or under any other theory of liability) for any loss or damage of any kind or nature related to, arising under, or in connection with, the
Materials (including your use of the Materials), including for any direct, indirect, special, incidental, or consequential loss or damage (including loss of
data, profits, goodwill, or any type of loss or damage suffered as a result of any action brought by a third party) even if such damage or loss was reasonably
foreseeable or Xilinx had been advised of the possibility of the same.Xilinx assumes no obligation to correct any errors contained in the Materials or to
notify you of updates to the Materials or to product specifications.You may not reproduce, modify, distribute, or publicly display the Materials without
prior written consent.Certain products are subject to the terms and conditions of Xilinx's limited warranty, please refer to Xilinx's Terms of Sale which can
be viewed at http://www.xilinx.com/legal.htm#tos; IP cores may be subject to warranty and support terms contained in a license issued to you by
Xilinx.Xilinx products are not designed or intended to be fail-safe or for use in any application requiring fail-safe performance; you assume sole risk and
liability for use of Xilinx products in such critical applications, please refer to Xilinx's Terms of Sale which can be viewed at
http://www.xilinx.com/legal.htm#tos.

Automotive Applications Disclaimer

XILINX PRODUCTS ARE NOT DESIGNED OR INTENDED TO BE FAIL-SAFE, OR FOR USE IN ANY APPLICATION REQUIRING FAIL-SAFE
PERFORMANCE, SUCH AS APPLICATIONS RELATED TO:(I) THE DEPLOYMENT OF AIRBAGS, (II) CONTROL OF A VEHICLE, UNLESS
THERE IS A FAIL-SAFE OR REDUNDANCY FEATURE (WHICH DOES NOT INCLUDE USE OF SOFTWARE IN THE XILINX DEVICE TO
IMPLEMENT THE REDUNDANCY) AND A WARNING SIGNAL UPON FAILURE TO THE OPERATOR, OR (III) USES THAT COULD LEAD
TO DEATH OR PERSONAL INJURY.CUSTOMER ASSUMES THE SOLE RISK AND LIABILITY OF ANY USE OF XILINX PRODUCTS IN
SUCH APPLICATIONS.

© Copyright 2014 Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Vivado, Zynq, and other designated brands included herein are
trademarks of Xilinx in the United States and other countries.All other trademarks are the property of their respective owners.

この資料に関するフ ィードバッ クおよびリ ンクなどの問題につきましては、 jpn_trans_feedback@xilinx.com まで、 または各ページの右下

にある  [フ ィードバッ ク送信] ボタンをク リ ッ クする と表示されるフォームからお知らせください。フ ィードバッ クは日本語で入力可能で

す。いただきましたご意見を参考に早急に対応させていただきます。なお、 このメール アドレスへのお問い合わせは受け付けており ませ

ん。 あらかじめご了承ください。
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